
Chapter 1
Contemplating the switch to 
ArcGIS Pro 

Background 
ArcGIS Pro will seem both familiar and completely new to users of ArcMap 
and ArcCatalog. The arrangement echoes the design of ArcMap: the map in 
the middle, map layers on one side, the data catalog on the other, with menus 
above (figure 1.1). Much of the architecture and terminology will persist in the 
new paradigm: geographic data, maps, layouts, geoprocessing tools, tables, 
joins, and so on. However, the implementation and details of how these func-
tions are accessed and manipulated takes a different approach in some cases. 
For users who know ArcMap well, the experience may initially be frustrating as 
you search for familiar tools and tasks that no longer appear in the same spot 
or as you get used to a new mindset for some tasks. 
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<alt>Map of Crater Lake in Oregon.</alt>

However, being open to a new way of doing things will have its rewards. 
New users unfamiliar with ArcMap seem to learn ArcGIS Pro more quickly 
as it follows modern software user interface (UI) conventions, using a ribbon 
with tabs and context-sensitive menus. In many aspects, it is more intuitive 
and more efficient. After some months of using ArcGIS Pro exclusively, I had 
to return to ArcMap for a month, and my immediate reaction was “Oh my, 
how clunky.” Hopefully after some practice, you, too, will grow to like the new 
software. 

Figure 1.1. ArcGIS Pro showing a map of Crater Lake in Oregon. 
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System requirements 
ArcGIS Pro requires a 64-bit multiprocessor machine with at least a dual core, 
and a quad-core processor or higher is recommended. Unlike ArcMap, ArcGIS 
Pro operates in a multithreaded manner, enabling it to take full advantage 
of multicore computers, which ArcMap could not. Significant performance 
improvements should be expected in most cases. ArcGIS Pro operates better 
when more cores are available. 

ArcGIS Pro requires a minimum of 8 GB of RAM and a graphics card with 
at least 4 GB of RAM and 24-bit display color depth. For a complete descrip-
tion of system requirements, consult the Esri product website, links.esri.com/
SysReqs.

ArcGIS Pro is tightly connected with ArcGIS Online, a cloud-based system 
built to encourage sharing of GIS data, workflows, and other resources between 
organizations and users. It is strongly recommended that you have an ArcGIS 
Online organizational account, which provides access to significantly more 
data and tools. ArcGIS Pro is also designed to run with a fast internet connec-
tion. Although you can run the software offline, provided the data sources are 
stored on your local computer, you will temporarily lose access to basemaps 
and internet-provided map services. If you’re planning to use ArcGIS Pro 
offline regularly, such as on a field laptop, it makes sense to limit maps and 
tools to use only local data on the computer’s hard drive. 

Licensing 
Because ArcGIS Pro is designed to interact with ArcGIS Online, its recom-
mended method of licensing is an ArcGIS Online organizational account. In 
this method, the administrator of an ArcGIS Online organization creates a user 
account and assigns an ArcGIS Pro license from among the total number allot-
ted to the organization. Extensions may also be assigned if available. Figure 1.2 
shows the screen the ArcGIS Online administrator uses to assign licenses and 
extensions to a user account. When starting ArcGIS Pro, you are asked to sign 
into ArcGIS Online using your account, which simultaneously licenses the soft-
ware and provides you access to any content you have created within ArcGIS 
Online. 
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<alt>Assigned software and extensions for an ArcGIS Online account.</alt>

For continuity with previous licensing methods, Esri also offers a concur-
rent licensing model and a single-use license model, both previously used for 
ArcMap licensing. In the concurrent model, a license manager program runs 
on a server and allocates licenses at a user’s request. This model is often called 
a floating license because it is assigned and then taken back when the user is 
finished, allowing a fixed number of licenses to be shared across many comput-
ers. In the single-use model, the license is tied to a specific computer. 

Capabilities of ArcGIS Pro 
Although it is different in many ways, ArcGIS Pro has the equivalent capabili-
ties of ArcMap and more. ArcGIS Pro 2.9, the latest version of the software at 

Figure 1.2. Configuring an ArcGIS Pro license for a user’s ArcGIS Online account. 
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the time of publishing this edition, represents another milestone with ongoing 
improvements. 

ArcGIS Pro integrates the functions of ArcMap, ArcCatalog, ArcToolbox, 
ArcScene, and ArcGlobe™ within a single interface so that 3D data visualization 
and analysis no longer require opening a separate program. ArcGIS Pro retains 
the Python and ModelBuilder™ customization modules. Certain aspects that 
users are accustomed to using as separate features, such as COGO or Maplex™, 
are now integrated directly into the program. The familiar extensions, such as 
ArcGIS Spatial Analyst™ or ArcGIS 3D Analyst™, continue to be available and 
work in much the same way as additional licensed tools in ArcToolbox. 

However, users should be aware that the design of ArcGIS Pro precludes 
certain familiar aspects of ArcMap from working in precisely the same way. 
In ArcGIS Pro, the design criteria specify that most actions are geoprocessing 
events (taking advantage of the multiprocessor computer). Tools have replaced 
some of the common right-click commands. 

TIP Can’t find something? Try searching for a tool. 

When should I switch? 
Several factors will affect your decision of when to switch to ArcGIS Pro. 

Reasons for making the switch include: 
• Improved performance that takes advantage of multicore architecture 
• Seamless integration of 2D and 3D visualization, analysis, and editing 
• Improved flexibility in creating dynamic labels 
• Creating multiple layouts based on the same map or maps 
• Tight integration with ArcGIS Online, making it easier to share maps 

and map services 
• A more modern and intuitive UI 
• Expanded use of defaults that can make life easier for inexperienced 

users 
• The product life cycle of ArcMap (see the Esri Support Product Life 

Cycles website, links.esri.com/ProductLife) 
ArcMap users may dispute the “more intuitive interface” claim when 

encountering ArcGIS Pro for the first time. In truth, the UI is probably more 
difficult to learn if you are accustomed to certain ways of doing things in 
ArcMap. In general, new users find the ArcGIS Pro UI easier to learn. Over 
time, you get used to it. 

The software also implements reasonable defaults more than ArcMap, 
hiding complications from beginners. This feature has both benefits and 
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pitfalls. For example, ArcGIS Pro does not automatically warn you when two 
geographic coordinate systems (datums) are used in the same map (although 
this warning can be turned on). This choice makes little difference unless 
you’re working at very large scales with precise data, and in many situations, 
the issue can be safely ignored. However, it can cause difficulties later if inex-
perienced users compile data for a project without being aware that the feature 
classes and rasters use multiple datums. 

ArcMap will continue to be available and people can continue to use it, but 
it will no longer be updated. A similar process occurred when ArcInfo Worksta-
tion and ArcView became ArcGIS Desktop. 

Several other factors must also be considered when making the switch: 
• ArcGIS Pro does not recognize personal geodatabases or ArcInfo 

coverages. 
• The organization and structure of maps and layouts are different. 
• Data management in ArcGIS Pro has complications not seen in 

ArcCatalog. 
• Absolute/relative paths are now fixed by default and have less flexibility. 
• Custom scripts and tools may need to be updated.
• Third-party extensions may not yet be supported.
As discussed in the next section, even though the data format is consistent 

(the geodatabase), the way that files are organized is altered and not as flexible. 
To switch to ArcGIS Pro, you must learn different ways of doing things. You no 
longer have a choice whether to use absolute or relative paths in a document; 
the choice is made by the software. This feature removes a potential trap for 
inexperienced users and the defaults work well but experienced users who are 
accustomed to controlling this option may need to change how they organize 
datasets. 

Mapping differences to consider before switching: 
• The default symbols follow a different cartographic style. 
• Labels are more flexible but the options are more numerous and take 

getting used to. 
• Previous custom style sets must be imported from the ArcMap symbol 

folder, although if a map document is imported, the symbols will be 
included. In general, the map document import function works well, 
although a few settings may not be preserved and will need to be reset, 
such as the data frame clip setting. Annotation can no longer be saved 
in a map as graphic text; it can only be created as a geodatabase feature 
class. 

Geoprocessing considerations to consider before switching: 
• Some familiar menu tasks are replaced by tools. 
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• Tool outputs are now saved to a project geodatabase by default. 
• Background processing is no longer visible. 
Overall, geoprocessing is similar, except that familiar functions, such as 

joining two tables, may now require running a tool instead of opening a menu. 
The spatial join, available in ArcMap as a relatively simple window, must now 
be run as the full tool, and although the tool has more options, it is complex 
compared with the simple menu in ArcMap. 

The background geoprocessing option has also disappeared in a sense. It 
is no longer a separate option. But ArcGIS Pro, with its multithreaded design, 
essentially runs all tools in the background, and it does so more quickly and 
reliably than the ArcMap background geoprocessor. 

All these factors and considerations will influence an organization on 
whether it is time to make the switch. Because ArcMap/ArcCatalog and ArcGIS 
Pro can be installed and run on the same computer, users have more time and 
flexibility when making the switch. (However, it is not recommended that you 
run both programs at the same time: both are memory intensive, and issues 
may result if you use both to modify the same data simultaneously). They use 
the same data models, so you can work with the same datasets using either 
program. However, maps and layouts are different. You can import an ArcMap 
map document to ArcGIS Pro and save it to the new format, but ArcGIS Pro 
cannot edit map documents, and ArcMap cannot work with ArcGIS Pro 
layouts. Once created, an ArcGIS Pro layout cannot be saved to the older map 
document format. 

Time to explore 
This exercise assumes that you have installed ArcGIS Pro, have been assigned 
an ArcGIS Pro license, and possess an ArcGIS Online organizational account. 
It is helpful to be familiar with the ArcGIS Online terminology for services, 
such as web maps, feature layers, and so on. 

Objective 1.1: Downloading the data for these 
exercises 

A set of data has been assembled to use with this book, and the data must be 
downloaded and installed on your computer. It is recommended that you keep 
data organized. It is best to put GIS data on drive C. The Desktop and user 
Documents folders don’t always work well, especially in networked environ-
ments. Do not use cloud storage services (such as OneDrive) with ArcGIS Pro. 
You can download the data from ArcGIS Online. 
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<alt>CraterLake data folder.</alt>
<alt>Folder contents shown in File Explorer.</alt>

The data is saved to a book group named Switching To ArcGIS Pro From 
ArcMap - 2nd edition (Esri Press) in the Learn ArcGIS organization.

Download the data

1. Go to links .esri .com/SwitchingToProData .

2. Download the zip file named SwitchToProData .

3. Extract the zip file . It will create a folder named SwitchToProData . Move this 
folder to drive C . The SwitchToProData folder contains a project folder named 
CraterLake and a PNG image named EdwardsCrop (figure 1.3a). Within the 
CraterLake project folder (figure 1.3b) is a file geodatabase, a TIN, a project 
file (.aprx), a layer file (.lyrx), a toolbox, a couple of JPEG images (.jpg), and a 
multiband Landsat 5 scene. 

Figure 1.3. Contents of the 
SwitchToProData folder as shown in File 
Explorer. 
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Objective 1.2: Starting ArcGIS Pro, signing in, creating 
a project, and exploring the interface 

The preferred licensing model for ArcGIS Pro uses a named user account, 
which is an ArcGIS Online subscription organizational account that your 
administrator has configured with an ArcGIS Pro license. If you have not run 
ArcGIS Pro before, it will prompt you to sign in. You will remain signed in for 
subsequent sessions unless you sign out or need to change accounts.

Instead of a map document used by ArcMap, ArcGIS Pro uses a more com-
plex data structure called a project, which will be presented in detail in chapter 
3. 

<alt>ArcGIS Pro sign-in screen.</alt>

1. Start ArcGIS Pro (figure 1 .4) and log in using your ArcGIS Online account . 
The initial start screen for ArcGIS Pro presents a variety of options (figure 1.5). 
On the left, you can open a project that is already saved by choosing one from 
the recent list or a pinned list or by browsing for another one. The middle 
section is used to create a project using one of the system templates: Map, 
Catalog, Global Scene, Local Scene, or Start Without a Template. The key 
difference is the initial type of display that will be created. The section on the 
right provides links to resources for learning more about ArcGIS Pro. 

Figure 1.4. The first time ArcGIS Pro starts, you will be prompted to enter your ArcGIS 
Online username and password.
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<alt>ArcGIS Pro start screen.</alt>

2. In the middle section, under the heading New, choose the Catalog template . 

3. Enter LearnPro for the project name (figure 1 .6) . Click the Browse button to 
specify the new SwitchToProData folder as the location . Keep the option to 
create a new folder checked and finish creating the project . 

<alt>Create a New Project screen.</alt>

4. On the right side, click Catalog to open that pane if necessary . Examine the 
interface . 

Figure 1.5. The initial start screen of ArcGIS Pro. 

Figure 1.6. Creating a new, blank project named LearnPro. 
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<alt>ArcGIS Pro UI with Catalog pane open.</alt>

TIP If your interface looks different from figure 1.7, close every window 
using the Close button in the upper-right corner until only the tabs 
remain. Then open the View tab and click the Contents button, the 
Catalog Pane button, and the Catalog View button (preferably in that 
order). You can use the View tab at any time if you inadvertently close 
one of these main panes. 

5. Examine the top of the UI containing the tabs used to access features and 
functions . 

6. Review the Contents pane (by default on the left side) . This pane behaves 
much like the ArcMap Table of Contents. 

Figure 1.7. The ArcGIS Pro UI showing a new project. 
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Unlike the Table of Contents in ArcMap, which shows only map layers, the Con-
tents pane in ArcGIS Pro portrays other types of content as well, as it does here 
in showing the contents of the project. 

The middle section shows the catalog view, which portrays the metadata for, or 
a preview of, items selected in the Contents pane. The catalog view is also used 
to edit metadata. 

7. Click several entries in the Contents pane . The catalog view updates to show 
the items contained within the clicked item. Note that in the top half of the 
Contents pane, the Project folder links to resources saved to the computer. The 
bottom half, the Portal folder, accesses internet resources. 

8. Explore the Catalog pane on the right side; it is analogous to the Catalog 
window in ArcMap . Although it is similar to the catalog view in the center of 
the UI, it has fewer functions (for example, not allowing you to preview data). 
The terms pane and view have specific meanings in ArcGIS Pro. Panes are 
dockable windows that contain commands and tools, whereas views contain 
objects that you are working with, such as a map, 3D scene, layout, or table. A 
window is a container that can display multiple panes or views. Three windows 
are visible in figure 1.7: one containing the Contents pane, one containing the 
catalog view, and one containing the Catalog pane. 

9. Compare the bottom of the Catalog pane in figure 1 .7 with your ArcGIS 
Pro UI . The window in the figure contains three tabs representing three 
panes docked in this window: Catalog, Symbology, and Geoprocessing. Your 
configuration may not match: the Symbology and Geoprocessing tabs may not 
have been opened yet in your project. One characteristic of the ArcGIS Pro UI 
is that it constantly changes depending on what you are doing. 

Objective 1.3: Accessing maps and data from ArcGIS 
Online 

ArcGIS Pro is designed to work closely with ArcGIS Online so that you can 
access maps and data that have been saved by others. In the Contents pane, the 
upper section, Project, lists data stored on the local computer or a local net-
work drive. The lower section, Portal, lists data available in ArcGIS Online or 
other GIS servers. My Content shows the content you have uploaded to ArcGIS 
Online, My Favorites lists the items you have made favorites, My Groups dis-
plays the ArcGIS Online groups that you are a member of and the content from 
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them, My Organization has all the items shared to your ArcGIS Online organi-
zation, and Living Atlas provides ArcGIS Living Atlas of the World content.

Much of the content accessed by ArcGIS Pro is like the content available to 
ArcMap, although the terminology has changed. 

Find and add data

1. In the Contents pane, under Portal, click ArcGIS Online . Make sure that 
the search type is set to Content rather than Groups. Note the types of items 
available. 

2. Click on one of the items to view its metadata . 

3. Switch between the Metadata, Geography, and Table tabs below the Search 
box . 

4. Right-click a web map  in the catalog view and click Add and Open . A web 
map is a shared map that accesses only GIS services. The map and its contents 
are displayed in the project. A new map view is added to the center window, 
and the Contents pane shows the map layers, much like the ArcMap Table of 
Contents. In the Catalog pane, the Maps folder now includes a map. 

5. Expand the Maps folder in the Catalog pane and note that the map is now 
listed there . 

6. Examine the ribbon along the top . It switched automatically from the Insert 
tab to the Map tab when the map was added. 

7. Switch back to the Insert tab . You may notice that additional commands are 
now available. Tabs update depending on what you are doing and what is open. 

8. Return to the Map tab, and examine it for familiar capabilities, such as the 
basemap, bookmarks, adding data, and so on . The catalog view remains 
open as a second tab in the center window. 

9. Use the tabs to switch between the map view and the catalog view . 
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10. Open the catalog view again and set the search filter to Layers . Right-click a 
feature layer  from your search and click Add to New > Map to add it to a 
different map . 

11. In the Contents pane, click twice slowly on the map name (currently Map) 
and change it to something more descriptive . 

12. Examine the contents of the Maps folder in the Catalog pane, noting that it 
now has two maps listed . 

13. Close one of the maps using the Close button on the tab at the top of the 
center window . The map closes but is still available in the Catalog pane. 

14. Click the Save button on the Quick Access Toolbar to save the LearnPro 
project . The connections to your new maps will be saved to the project. 

Like ArcMap, ArcGIS Pro stores only the links to these ArcGIS Online maps 
and data services. 

TIP Maps in projects are analogous to data frames in an ArcMap map 
document. 

Objective 1.4: Arranging the windows and panes 
As in ArcMap, windows can be docked in the program or float above it. Objects 
within windows can be rearranged: stacked on top of each other, side by side, 
top over bottom, and so on. The docking icon is already familiar to ArcMap 
users, and it works much the same way in ArcGIS Pro (figure 1.8). 

<alt>The docking icon.</alt>

Arrange and dock objects

1. In the center window, click the Map tab and drag it to pull it out of the 
window, making a new floating window . 

Figure 1.8. The docking icon is used to arrange panes within a 
window: stacked (drop on the center) or side by side (left, right, top, 
or bottom). 
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2. Drag it back into the center display area to make the docking icon appear . 
Drag the Map tab to the center of the icon and release to stack the map on 
top of the catalog view again . 

3. Drag the map away again and use the docking icon to arrange the map 
view and catalog view side by side . Experiment until all five docking 
locations have been used . 

4. In the Catalog pane, open the Maps entry if needed and double-click the 
second map to open it . 

5. Experiment with arranging the three views . Panes can also be arranged 
within their windows. 

6. Open the second map, the one containing the feature layer, and click its title 
bar to ensure that it is the active view . The Contents pane shows the content of 
the active view. 

7. If the feature layer loaded as a group layer, expand it until an individual 
layer is visible . 

8. In the Contents pane, right-click the layer and click Symbology to open the 
Symbology pane . 

9. Drag and dock the Symbology pane below the Contents pane, on top of the 
Catalog pane, next to the Catalog pane, and so on until you’re comfortable 
with arranging panes . 

10. Save the LearnPro project . 

TIP When two panes are stacked in a window, use the top bar to move the 
window with all the panes together. To move a single pane out of a 
window, click its tab on the bottom. 

Objective 1.5: Accessing ArcGIS Pro Help 
The ArcGIS Pro Help files are normally accessed in a web browser window, 
rather than being part of the program as in ArcMap. For offline work, the 
ArcGIS Pro Help files can also be downloaded and installed separately. 
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Explore Help topics

1. On the ribbon, click the Project tab and click Help . Your default browser 
opens to the ArcGIS Pro Help pages. 

2. Widen the browser window, if needed, to see the outline on the left and the 
text on the right (figure 1 .9) . 

3. Expand some topics in the outline to explore the content and organization . 

4. Find the Search box and type a search term, such as labels, click Search or 
press Enter on your keyboard, and select one of the topics that appears . 

5. Examine the path to locate the content in the Table of Contents outline . 
Click a higher level to access more general topics . 

6. Examine each of the tabs and return to the Help tab . 

7. Spend some time exploring ArcGIS Pro Help until you are comfortable using 
it . 

8. Minimize the browser, making the Help access quicker next time, and return 
to ArcGIS Pro . 

<alt>ArcGIS Pro Help.</alt>

 Figure 1.9. ArcGIS Pro Help section on “Maps in ArcGIS Pro.”
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Objective 1.6: Importing a map document 
In ArcGIS Pro, you can import existing map documents from ArcMap. Every 
data frame in the map document will be imported as a map, and new layouts 
will be created in the project. Folder connections needed to access the data in 
the map document, styles used to display the features, and most data frame 
and layer settings will be imported. If you have a map document (.mxd) on 
your computer, you can import it now. 

Import a map from ArcMap

1. Close any open maps . 

2. Open the Insert tab, and in the Project group, click the Import Map button . 

3. Browse to a map document, select it, and click OK . Wait while the map 
document imports from ArcMap—it may take a few minutes . 

4. Examine the map views in the main window . One is created for each data 
frame in the map document. 

5. In one of the imported maps, double-click a layer to open its properties and 
examine the Source setting . Close the properties when finished . The map 
layer data is imported as paths to the original source in its original location. No 
data will be copied to the project. 

6. In the Catalog pane, expand the Layouts entry and find the new layout 
added from the map document . Double-click it to open it . Most settings 
will be copied to the new layout, but you may find a few that are not because 
of differences between ArcMap and ArcGIS Pro. You may need to adjust some 
layouts or maps to get the same result as the original. Once imported, however, 
layouts cannot be exported back to the ArcMap format.

7. Examine the layout for differences between the ArcGIS Pro and ArcMap 
versions . 

8. In the Catalog pane, expand the Styles entry . Custom styles used in the map 
document, if any, are imported and shown here. Remember, ArcGIS Pro can 
have multiple layouts. 
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9. Optionally, import another map document . 

10. Save the LearnPro project to save the imported maps and layouts . 
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